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Prefacg

The QMTech® QM_MAX10_10M02SCU169 Development Board uses Intel® 10M02SCU169
device to demonstrate Intel® MAX® 10 FPGAs revolutionize non-volatile integration by delivering
advanced processing capabilities in a low-cost, single chip small form factor programmable logic
device. Building upon the single chip heritage of previous MAX device families, densities range
from 2K — 50K LEs, using either single or dual-core voltage supplies. The MAX 10 FPGA family
encompasses both advanced small wafer scale packaging (3 mm x 3 mm) and high 1/O pin count
packages offerings.
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1. Quartus Prime 15.1 Installation

The revolutionary Intel® Quartus® Prime Design Software includes everything you need to design for
Intel® FPGASs, SoCs, and CPLDs from design entry and synthesis to optimization, verification, and
simulation. Dramatically increased capabilities on devices with multi-million logic elements are providing
designers with the ideal platform to meet next-generation design opportunities.

The Intel® Quartus® Prime Software design flow comprises of the following high-level stepﬁ

CREATE CONSTRAIN COMPILE CLOSETIMINGON  CONFIGURE YOUR DESIGN
YOUR DESIGN YOURDESIGN YOUR DESIGN YOURDESIGN ONTHEBOARD
The Quartus Prime software version 15.1 supports the following device’ f AStratix 1V, Stratix V, Arria
I, Arria V, Arria V GZ, Arria 10, Cyclone IV, Cyclone V, MAX I, X10 FPGA. Below image
shows the startup Ul of Quartus Il Prime 15.1:

@ Quart o~

- e )
D d bnc v SELTDr YO OAVR
Promct Navigator 2\ Mierarchy =98 L Homs [x) P Cataog. g8 :

i
!
§

Start Designing

) Wi Documentation O About Quartus Prime
1810 B0 128
< e Y
New Project Wizard ‘Pmnw Hone

e Support
Copyrght (C) 1991-2015 ABera Corporaton. A g esenved. Quarus s 8
Sounine

ﬁ @ VWrat's New 1 cote

‘ Notification Center

Open Project

Recent Projects

HolloWorld.qpf (€ /Allera’ asicHolloWorld Warning. This computer program s profecied by copyright aw and
B DEO_CV_SORAM Nios_Test.qpt o js_TesUDEO_CV_SDRAM_Nios_Test pf)
Test07_USB_Slave_FIFO.qp! (E C |_HS_USB_CY7CE8013/Test07_USB_Siame_FIFOTestd7_USB_Ste
I Testi_project ADV7123 VGA.qp (E-/Altera/Sotware/Test06_project_ADVT123 VGA/Test06_project ADV7123 VGA agf)

Brogram. or any porion of 1, mey resull n savere civl 853 Crimes! penalies,

e

<
T‘E{e 0 Message
]
L

?\ Sysem  Processmg

mm | __ v
= Figure 1-1. Quartus Il Prime 15.1

fter the,Quartus Il Prime 15.1 is correctly installed, users still need to install the device package from
teWicial website. Below lists the download center address:
https://www.intel.com/content/www/us/en/programmable/downloads/download-center.html

0% 090000

In the Intel Download Center website, select the tab of  Select by Device’ and then all the available
device packages will be listed as below image. The device used in this user manual is MAX10 series
CPLD and the detailed chip part number is 10M02SCU169C8G, so please download the device package
for Quartus Il 15.1: max10-15.1.0.185.qdz.

©

aMTECH QM_MAX10_10M02SCU169 Development Board User Manual-V01



Select by Version ‘ Select by Device Select by Software
Devices

- N Quartus Edition Version Listing

~ B Arria Series &3 Standard Edition i
- @ Cyclone Series
4 B max series
. MAX 10
N MAX V
o MAX I
Y MAX 7000
% MAX 3000A Lite Edition

- 0 HardCopy Series ~
b "y

~N® o
[

Subscription Edition

Web Edition

o | e | e e e e e e | e e e e e
L R L I = = e I == I = = B
OO OO | OO RO | = OO

[l [«[[ [«clrFeE= [eere-

Open Quartus 11 15.1, Click I

Oh Quartus Prime Standard Edition
Fle Eot View Puject Assgments Processeg Toss | Weow hep @
OmE+E0 " Fun Simuiaton Tool

2. Lsunch Simultion, Lirary Compler
Progct Navigstor Syhechy =g
%, Launch Design Space Explorer |
Ay Compastion frerarchy.

© TewouseiTing Arabze

Advisoen

ii Documentation
o cng Punnr
4> Dosign Pariton Pannar & ranng
Hetst Vewers

D SigaalTap Logi Analyzer esuppnn
= inSystem lemory Cansent it
] Loge Ansiyzer hisctace Edtor
1 mSystee Suurces a0d Frobes Edter
Signarobe Prs
B Programmer ‘lerlchlmn Center
M8 TAG Chan Detugger
D Fautection Detugser

.' What's New

System Detugging Toos

S Pesung
i 1S B ook o Ecose

& sy LN
# Tasoi ave_FIFO.qpl (E-/ARerat 1.1 _Stave_FIFO.qpf)
e ADVTTZ3 VGA.qp (E 4 ojec I AT

Figure 1-3. Install Device Package

4
aMTECH QM_MAX10_10M02SCU169 Development Board User Manual-V01



Below window will pop up and click Next:

(O Installing Quartus Prime Standard Edition 15.1.0.185 Devices - O *
Setup - Quartus Prime Standard Edition 15.1.0.185 Devices

‘wielcome to the Quartus Prime Standard Edition 15.7.0.185 Devices Setup Wizard,

The Quartus Prime software requires that your system have sufficient physical RAk to compile designs
targeting specific devices. You can check the "Memory Recommendations' section in the "Quartus
Prime Software and Device Support Releaze Motes" [https: /v, altera. com/suppartliterature.lit-
n.html] for detailed mernory requirements for a particular device,

For more information about &ltera software, go to http: /v, alkera.com.

< Back | Mest | | Cancel

Figure 1- ice Package
Choose the Download Directory where contain max10-15.1.0.185.qdz file:

(&8 Installing Quartus Prime Standard Edition 15.1.0.185 Devices — O X

Download Directory M-;m
®

Specify the directary that containg the Quartus Prime device files [.gdz).

Download directony: | E:\Alkera\MAx1 0\Docs |

If you need to download device support files, you can download them from the Download Center page of the Altera website:

http:#/dl. altera. com, ?edition=standard/ ftabs-2

\g’/\

InistallBuilder

| < Back || Mext > || Cancel

Figure 1-5. Choose Device Package

4
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Choose the device package needs to be installed and click Next:

User could also install the device packag

(4

aMTeECH

(& Installing Quartus Prime Standard Edition 15.1.0.185 Devices

Select Components

/AVOTS RYAN,

Select the components pou want ta install

B Quartuz Prime Standard E dition
=R Dievices
ks 10 FPGA [348.2MB]

*t'ou can add additional device support to an existing
Quartuz Prime software installation without having to
reinztall the entire zoftware package. Use the Instal
Devices command on the Tools menu in the Quartus Prime
software ta get started,

Select a compaonent for more infarmation

InstallBuilder

< Back Mext » Cancel

Figure

B 7z

Adobe Acrobat DC

Adobe Acrobat Distiller DC
Adobe Photoshop CS6

Adobe Reader X1

Altera 15.1.0.185 Standard...

Microsoft Edge BB

IH Nios 1l 15.1 Command Shell

B nios 1115.1 Documentation g

5
(N} Nios 11 15.1 Software Build To... 128

. Snake Pass
& Quartus Prime 151 34

Quartus Prime 15.1 Device Installer [

= = Microsoft Stort
W Quartus Prime 15.1 Device Ins... Lol

H

Quartus Prime 15.1 Program...

[H Quartus Prime 15.1 TalkBack I... E E
Bz (2) Bz (2)

m o i © g

. Install,the Device Package

BRGNS

G as
° -

Groove B5 FRRANEEN

OneNote

- 4

Media Suite E...

Dell

-

Figure 1-7. Device Installer
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2.1

CPLD Project Compile and Download

Create New Project

Click [File] > [New Project Wizard...] to create a new project:

il Edt  View

f~

&
5]

o

i
L

Project  Assignments

(G uartus Prime Standard Edition
=
] » Cirl=t E

Procesghy  Tools  Window

Help @
NS SR D FED LD

Open...
Close

Ctri+0
Ctri«F4

New Projsct Wizard.
Open Project.. CiriJ
Save Project

Closz Project

Save Cirl+S
Save As.,

Save Al
File Properties.

Create / Update
Export..
Convert Programming Files.

Page Setup.
Print Preview

Print. Ctri=P.

Recent Files
Recent Projects

Exit Alt+F4

Cirl+Shift+5

aa x|

ii Documentation

W Training
a Support

N / _.- What's New

‘ Notification Center

Open Project

Recent Projects

HelloWorld.qpf (E:/Altera/Software/Test08_project_NIOSS_II_Basic/HelloWorld.qpf)
DEO_CV_SDRAM_Nios_Test.qpf (E-/Altera/Software/DE0_CV_SDRAM_Nios_Ts '_SDRAM_Nios_Test qpf)

Test0T_USB_Slave_FIFO.qpf (E:/Altera/Software/Test07_project_HS_USB_t }Test07_USB_Slave_FIFO/Test07_USB_Slave_FIFO.qpf)

Choose [New Quartus Prime Project] :

\g'/\

(4
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Test06_project ADVT123_VGA.qpf (E:/Altera/Software/Test06_project ADVT123_VGA/Test06_project ADV7123 VGA.qpf)

rea

Figure

aNew

New CQuartus Prime Project ~

. )
AHDL File
Block Diagram/Schematic File
EDIF File
Q=ys System File
State Machine File
SystemVerilog HDL File
Tel Seript File
Verilog HOL File
WHOL File

w Memory Files
Hexadecimal (Intel-Format) File
Memory Initialization File

* erification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalTap |l Logic Analyzer File
University Program WWF

w Other Files
AHDL Include File
Block Symbol File
Chain Description File

[ ox Cancel

Help |

Figure 2-2. New Quartus Prime Project
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In below [ New Project Wizard] page, choose Next:

Ok New Project Wizard x

Introduction

The New Project Wizard helps you create a new project and preliminary project settings, including the following:

Project name and directory

Name of the top-level design entity
Project files and libraries

Target device family and device
EDA tool settings

“fou can change the settings for an existing project and specify additional project-wide settings with the Settings command (Assignments menu). You can
use the various pages of the Settings dialog box to add functienality to the project.

LR X XN ]

I:‘ Don't show me this intreduction again

- /
Figure 2-3. New, e izard
Set the target working folder below [Whatis ng directory for this project?] . Set the new project
1

name below [What is the name of thi jec d finally set the example project name:
Test01_Project_LED shown as belo
Ok New Project Wizard s

Directory, Name, Top-Level Entity

Nnat is the working directory for this project?
[Etest =1
‘What is the name of this project?
[Testo1_project_LED =]
‘What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name in the design file

dTm{m_ijem_LED =]
Use Existing Project Seftings...

N 4

\g'/\

4
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Figure 2-4. Set Working Directory and Project Name



Select [ Empty Project] and then click Next:

If user already has some source code,

(4

aMTeECH

O New Project Wizard

Project Type

Select the of project to create.

Empty project

Create new project by specifying project files and libraries, target device famity and device, and EDA tool settin
O Project template

templates from the Design Store.

Create a project from an existing design template. You can choose from design templates installed with the Quartus Prime software, or download design

| <Back || Hext = || Finish || Cancel || Help

>

ty Project

these necessary files in this step:

Ok New Project Wizard
Add Files

Select the design files you want to include in the project. Click Add All to add all design files in the project directory to the project.
Note: you can always add design files to the project later.

File name: | ":l
&

Add

X| Add Al

File Mame Type Library Design Entry/Synthesis Tool HDL Version

Remove
Up
Down
Properties.
Specify the path names of any non-defaul libraries.
| <Back | [ Mext> || mmsh || cancal || Hep

Figure 2-6. Add Source Code
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Choose the CPLD Chip number: 10M02SCU169C8G

b New Project Wizard

Family & Device Settings

Select the family and device you want to target for compilation

*ou can install additional device support with the Install Devices command en the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device famity

hd |

Family: | MAX 10 (DADFIDCISAISFISC)

hd |

Devices: | MAX 10 5C

Target device
Auto device selected by the Fitter
@ Specific device selected in ‘Available devices' list

Other. nfa

Available devices:

Show in ‘Available devices' list

Package |uFaGaA

Fin count; | 189

‘Core Speed grade: |3

Name fiter: | ‘

[ Show advanced devices

10M08SCUMGSCEG 3.3V
10M16SCUMESCEG 3.3V

Einish H Cancel H Help

re’s nothing needs to be changed:

Ok New Project Wizard

Summary
‘When you click Finish, the project will be created with the following settings:

Project directory:
Project name:
Top-level design entity:
Number of files added,
Number of user libraries added:
Device assignments:
Design template:
Family name:
Device:
EDA tools:
Design entry/synthesis:

’ Simulation
Timing analysis:
|| ‘Operating condtions:
_ Core voltage:

Junction temperature range:

C:/Usersfevelovely/Desktop
test

test

o

o

nia
MAX 10 (DADF/DCISAISFISC)

10M02SCU169CEG

<None> (<None>)
<None> (<None>)

0

33V

0-85°C

X

Hext> Fnsh || cancel | Hep

Figure 2-8. Project Summary
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After the Empty Project created, below image will be shown:

{Sh Quartus Prime Standard Edition - Ey/Altera/Software/Test01 _Project LED/Test01_Project LED - Test01_Project LED
File  Edit L ]

OFEH 4NN C furmim | /682 Dr¥ES @40E

Project Navigator ., Hierarchy

View Project Assignments Processing Tools Window Heip

Entity-instance
4 Cyclone V: SCEFA2F23C8
Test01_Project_LED "ty

( Quartus:Frime

- o X

Search akera.com (]

‘IP Catalog

ng x
o« X =

~ g installed P
~ Project Directory

No Selection Avaiable
v Library
5 Basic Functions.
DSP
Interface Protocols.

Memory interfaces and Controllers

Universty Program

>
>
>
> Processors and Peripherals
>
@ search for Partner P

< > + Add
*|[Type  ID  Message

&

#

ﬂ System  Processing

0% 00:00:00
Table 2-1. Empty Proj
Users may add example source file TestOl_Project_LED.W thi y{Project shown as below:
(b Quartus Prime i i B est01 Project LED - Test01 Project LED “ [m] X
File Edt Viewf| Profct  Assignments Processing Tools Window Help .
H D B g ‘Add Current File to Project

HEoTr¥ES @AVE

Project Navigator .

g1 Revisions.
i Cyclone V: SCEF. Copy Project.
B Test0!_Proje Clean Project.

Archive Project.
Restore Archived Project..

a::;m: Quartus Prime

Export Design Parttion.
Generate Design Parttion Scripts.

Generate Tol File for Project
Genarats PowsrPlay Early Power Estimator Fiis
Upgrade IP Components.

Organize Quartus Prime Settings File

‘\p Catalog

~ G mstaled P
v Project Directory
No Selection Avaiable

v Library
> Basic Functions
> Dsp
> Interface Protacols
> Memory Interfaces and Controlers.
> Processors and Peripherals
> University Program

@ search for Partner IP

Opens up Settings dialog to add/remove files in project

‘l
Table 2-2. Add Source File

+ Add
2 setasTop-Level Entiy Cirl=Shifts)
*|[1ype 1
a Hierarchy »
8
g
@
ﬂ System  Processing

00:00:00

—” Settings - Test01_Project LED - m}

4

X

p— ooy
Files.
Libraries Selectthe design files you want to include in the project. Click Add Allto add all desian files in the project directory to the
\ v IP Settings project
IP Catalog Search Locations
Design Templates i name: | =] [ ade
v Dperating Settings and Conditions [ ’W‘
Voltage =
Temperature File Name Type Library Design Entry/Synthesis Tool  HD)| m,-e
~ Compiation Process Settings ‘SourceiTest_Project LED.v; Verilog HDL File <None=> De
Incremental Compilation Chaind.cdf Chain Description File <None> Up
v EDA Tool Settings
Design Entry/Synthesis Down
Simulation
Formal Verification
Board-Level
v Compiler Settings

Table 2-3. Add Source File

(4
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After the newly added source file loaded into project, user can view the source code shown as below:

G Quartus Prime Standard Edition - Ey/Altera/Software/Test01_Project LED/Test01_Project LED - Test01_Project LED

- a X

File Edt Wiew Profct Assignments Processing Tool Window Help @ .
OFdE«Dh ’)('“—‘usmumpmmj S EEHDrrES DAVE
Proct Navigstor oy Werarchy = = @@ x Test01_Project LED.v [x] [P cototog
Entity:nstance EHer jul ﬂ‘h 0w 9 %= (&
Cyclone V: SCEFA2F23C8 1 timescale 1ns ~
s Cyctoc 2 ////////////////////////////////////////////////////////////////////////////////// ~ i nsilea
FB Test01_Project LED 3 1/ c v Project Directory
a 7 :ngmeer
5 7 Ho Selection Avalable
6 // €reate pate: 13:40:55 02/28/2016 ;
7 // Design Name: ' Library
8 // ModuTe Name: Test0l_Project_LED > Basic Functions
9 // Project Name: > DSP
10 // Target Devices:
11 // Tool versions: > Interface Protocols
B ;; pescription: > Memory hterfaces and Controlers
i‘; // Dependencies: > Processors and Peripherals
16 ;; Revision: > University Program
17 7/ Revision 0.01 - File Created @ searcn for Partner P
18 ;; Additional comments:
19
20 //////////////////,//////////////////////////‘W////////////////////////////////////
21 @module TestOl_Project_LED(
22 \‘ input sys_clk,
23 input sys_rst_n,
24 output Ted_1
25 :
26
27 parameter DLY_CNT = 32'd50000000;
28 parameter HALF_DLY_CNT = 32 d25000000;
29
30 (*mark_debug = "true"*)reg r_
31 C*mark_debug = "true"*)reg [n S count;
32
38 //counter contr.
En a'\ways@(posedge sys clk or negedge sys_rst_n)
35 Ebegin
36 | wf('sys rst_nj
7 =
38 (Dlln[ <= 32'd0;
39 en
40 else 1f(:ourrt == DLY_CNT)
a1~ beain
>||< + Add..

Type ID  Message

Messages Il = @ x [[~

System  Processing

Ln20  Col4s

0% 00:00:00

Compile the Project
Users could use the button [ Start Compil

(O Quartus Prime Standard Edition - E:fAltera/Software/Test01_Project LED/Test01 Project LED - Test01 Project LED

Figurer2-9.
]

of Source Code

— Ctrl + L] shown in below image to compile the project:

— [m) x

File Edt View Project Assignments Processing Tools Window Help @
OFWH 00 D C[[fenrmm | /ss:lor ¥ o @agE
Project Navigator, 4 Hierarchy eI L3 Test01_Pre B ‘\Pcatalug nE x
Entity instance =) ['i' D uild ‘h 0 ‘Q Xl =)
1
Cytione V: SCEFAZF23C8
M\E;;D " 2 ////////////////////////////////////////////////////////////////////////////////// ¥ nstaled P
i LU H v Project Directory
1 // Engmeer
5 Ho Selection Available
6 // Create Date: 13:40:55 02/28/2016 .
7 /7 pesign Nam 7 tbrary
8 // moduTe Nam Test0l_Project_LED > Basic Functions
9 // Project Nam > DSP
10 // Target pevices
11 // Tool vers : > Interface Protocels
g ﬁ Description: > Memory interfaces and Controllers.
14 // pependencies: > Processors and Peripherals.
}2 ﬁ Revision: > University Program
17 // Revision 0.01 - File Created @ search for Partner P
18 ﬁ Additional comments
19
20 O e
21 module Test0l_Project LED(
22 input sys_clk,
23 input sys_rst.n,
24 output Tled_1
25 )
26 L
27 parameter DLY_CNT = 32'd50000000;
- 28 parameter HALF_DLY_CNT = 32'd25000000;
29
30 (*mark_debug = “true"*)reg r
31 (*mark_debug = "true"*)reg [n D](Dun‘t
32
33 //counter contr
3 aﬂways@(posedge sys clk or negedge sys_rst_n)
35
36 g1f('5y5 rst_n)
37 begin
38 count <= 32°d0;
39 en
40 else if(count == DLY_CNT)
a1 beain
>« + Add..
*|Type ID Message
-
7
8
i
| 2] system  Processing

Starts a new compiation

(4
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Figure 2-10.  Compilation
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There will be compilation report after the compile finished, in which shows the info like logical element
resource usage, how many PLLs are used, etc. Below image shows an example Compilation Report:

2.3

Gk Quartus Prime Standard Edition - Ey/Altera/MAX10/Software/Test01_LED/Test01_LED - Test01_LED — [m] X
File Edit Wiew Project Assignments Processing Tools Window Help @ .
OFE <00 DCimnw -/ &$E2CrFES OA0E
PrDie:tNavigatDri 2, Hierarchy v|5 s x| & Test01_LED.v a ¢ Compilation Report - Testd1_LED (%]
Entiy-instance Table of Contents na
5 ful - Mon Apr 23 22:37:50 2018 ~
My MAX 10: 10M025CU169CE0 EH Flow Summary eTetlLeL Gy
Quartus Prime Version 15.1.0 Build 135 10/21/2015 SJ Standard Edition
BB Testo1_LED o B Flow Settings N
L S5 Flow Non-Defaut Global Seft Revision Name Test01_LED
ow Non-Detaull Global SENgs | | op tevel Entry Name Test01_LED
EH Flow Elapsed Time Family MAX 10
EH Flow 0 Summary Device 10M025CU169CEG
@ Flow Log Timing Models. Final
> I Analysis & Synthesis Total logic elements 6472304 (3% )
> B Fiter Total combinational functions ~ 64/2,304 (3% )
> B Assembler Dedicated logic registers 3472304 (1% )
5> W PowerPlay Power Analyzer T EEEES =
Total 41130 (3%
© Fow Messages TS (3%)
© Fows o Total virtual pins 0
oW Suppressed Nessa0es || roal memory bits 0/110,592 (0% )
> B TmeQuest Timing Analyzer Embedded Multiplier 9-bit elements  0/32 (0 %)
Total PLLs 0/1(0%)
o |2 5 || UFM blacks 0/1(0%) -
|| Type 1D Message A
8 &, 332148 Timing requirements not met
/5 @ 332146 worst-case setup slack is -1.000
=lls @ 332146 worst-case hold slack is 0.252
© 332140 No Recovery paths to report
@ 332140 No Removal paths to report
> ) 332146 worst-case minimum pulse width slack is -3.000
@ 332102 pesign is not fully constrained for setup reguirements
@ 332102 pesign is not fully constrained for hold requirements
> @ Quartus Prime TimeQuest Timing Analyzer was successful. 0 errors, 4 warnings
w @ 293000 Quartus prime Full compilation was successful. 0 errors, 12 warnings ©
i
2l< b3
i
2| System  Procassing (123)
100%  00:01:22

PIN Assignment

There are several ways to assign the

[ Pin Planner]

L '
Flg@mnmlon Report
s/forthe

ple project. Method 1: Choose [Assignment] >

g

(4
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Edits pin assignments.

Figure 2-12.

Pin Planner

QM_MAX10_10M02SCU169 Development Board

(¥ Quartus Prime Standar gkt D/Test01_LED - Test01_LED - m} x
File Edit View Projct [l Assignments Processing Tools Window  Help | .
.
= ] =;D"‘”°a L& DrFES LIS
" settings Cirl+Shift+E
Project Navigator| ., Hierarchy) D B ¢ Compilation Report - Test1_LED [x]
Emg Assignment Editor (2NN ] Flow Summary
| [Flow Stat s ful - Mon Apr 23 22:27:50 2018 ~
2y MAX10: 10MO25CU169CE w Status LRSI s
Quartus Prime Version 15.1.0 Build 185 10/21/2015 SJ Standard Edition
BT Testo1_LED ry Remave Assignments.
b - Revision Name Test01_LED
IS Back-Annotate Assignments... MG || 10 vl Entty Name Test0 LED
Import Assignments... Family HMAX 10
Export Assignments... Device 10M0Z5CU169CEG
Assignment Groups. Timing Models Final
Total logic elements 6472304 (3% )
&  LogicLock Regions Window AltsL Total combinational functions ~ 64/2,304 (3% )
%% Design Partiions Window AlD Dedicated logic registers 3472304 (1%)
T PowerPlay Power Analzer EEELEES &
Total 41130 (3%
© Fow Messages S &)
© Fows sl Total virtual pins 0
o Suppressed essages | rotal memory bits 0/110,592 (0% )
> I TmeQuest Timing Analyzer Embedded Muttiplier -bit elements 0732 (0% )
| Total PLLs 0/1(0%)
== 3 | |UFM blocks 0/1(0%) v
| Type Ip Message -~
g A 332148 Timing requirements not met
Al > @ 332146 worst-case setup slack is -1.000
=l @ 332146 worst-case hold slack is 0.252
@ 332140 No Recovery paths to report
© 332140 No Removal paths to report
> @ 332146 worst-case minimum pulse width slack is -3.000
@ 332102 Design is not fully constrained for setup requirements
@ 332102 pesign is not fully constrained for hold requirements
> @ Quartus Prime TimeQuest Timing analyzer was successful. O errors, 4 warnings
" @ 293000 Quartus Prime Full Compilation was successful. 0 errors, 12 warnings o
8
® < >
@
| 2| system  Processing (123)

100% 00:01:22
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aMTeECH

Below image shows PIN settings for this

test example:

Fie Edt Wiew Projsct Assignments FProcessing Tools Window

D= |l B| D ¢ |if=ms

L

Help.

IOk Quartus Prime Standard Edition - E:/Altera/MAX10/Software/Test01_LED/Test01_LED - Test01_LED

SELDTrFESSLYE

[m] X

Search altera.com ]

Project Navigatar| i\ Hierarchy v |=[g/@ x| @ Test01_LED.v ] & CompiatonReport-Testol_LED [] & Fin Plannar x|
i Report & x
Entity Instance " 2 Top View - Wire Bond
A WAX 10: 101025CU185C3G x Report not avaiable MAX 10 - 10M02SCU169CEG
Test01_LED £y
a T s
W * VOO0 00BCO0C0OY -
hn) = HOPOOOAVD
= DOVOD,
]
(* Groups  Report
i Tasks a8 x
B ~ [~ Early Pin Planning a
@ W Early Pin Planning...
o P Run VO Assignment Analysis
= W Export Pin Assignments..
I _Pin Finder... &
x | Named] = « Jes et 56 Fiter: Pins: al -
: %W led_1 Output PIN_F9 [ BE_NO PIN_F9 33V LVITL BmA (defau
) ol led 2 Output PIN_F10 6 B5_NO PIN_F10 33VLVITL BmA (defau
& sys_ck Input PIN_HE 2 B2_NO PIN_HE 3.3V LVTTL BmA (defau
& L sys rstn Input FIN_G13 5 B5_NO PIN_G13 33VLVITL BmA (defau
i <znewi node=>
& 0
2
[
> v |F|¢ >
* || Type o Message ~
=} &, 332148 Timing requirements not met
R[> @ 332146 worst-case setup slack is -1.000
=« #m 332146 worst-case hold slack is 0.252 A
€ >
4
£| system  Processing (123)
100%  00:0122

Method 2: Prepare a *.csv file from other
import the existing *.csv file to allocate

Fig

-
uré2:13,
jeet,
inas

lb\ssignment

se [ Assignment] >

ent:

[ Import Assignment] to

(S Quartus Prime Standard Eg . o = 101 Project_LED - Test01_Project LED - m| X
Fie Edit View Project ffAssignments Processing Tools Window Help @ .
D d [« Dl o= ¢4+ CrrKQISAVE
' Sett Cir+Shift=E
Proiect Navigator . Hierarchll ~ o e Testll Project LEDY [x] [Peatang ne x
entl] &  Assignment Editor orsshitsa K mfl) W B 2= |‘ X‘ =
Cyclone v SCEFAZF23CAl &5 Pin Planner CirisShiftsN Ip - -
M\ o fros Wl s v b nstaled P
T Test0t_Project LED emove Assignments...  Project Directory
I Back-Annotate Assignments... N Selecton Avaiable
Import Assignments... :40:55 02/28/2016 v Library
~ Export Assignments. est01_Project_LED > Basic Functions
- > Dsp
s > interface Protocols
& LogicLock Regions Window AL
> Memory Interfaces and Controllers.
& Design Parttions Window AlD O ——
i 7% mevision: > University Program
17 // Revision 0.01 - File Created @ search for Partner I
18 ;; Additional Comments:
19
20 N T N N e g
21 module TestO0l Project LED(
22 input sys_clk,
23 input sys_rst_n,
24 output led_1
25 2
26 ]
27 parameter DLY_CNT = 32°d50000000;
28 parameter HALF_DLY_CNT = 32'd25000000;
29
30 (*mark_debug = "true"*)reg r_led;
31 (*mark_debug = "true"*)reg [3l:0]count;
32
33 /{counter control
34 always@(posedge sys_clk or negedge sys_rst_n)
35 egin
36 if(lsys_rst_n)
37 begi
38 count <= 32°do;
39 en
40 else if(count == DLY_CNT)
41 beain ks
3| < > + Add
x||Type  ID Message a
&| @ 332102 Design is not fully constrained for hold requirements
& Quartus Prime Timequest Timing Analyzer was successful. 0 errors, 5 warnings
=| @ 293000 quartus Prime Full Compilation was successful. O errors, 9 warnings
» v
g, D
2
2| system | Processing (111)
Imports assignments from other sources 100%  00:01:30

(4

Figure 2-14.

Import Assignment
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2.4 Download *.sof into FPGA

After the test example correctly compiled, the Quartus will generate a *.sof file which could be directly
loaded into FPGA to check whether implemented functions perform as expected. User could use
[Tools] - [Programmer] to start a new download:

(G Quartus Prime Standard Edition - E:/Altera/Software/Test01_Project LED/Test01 Project LED - Test01 Project LED

[m} X

Fic Edt View Project Assignments Processing Tools  Window Help @ [search ateracom | @

O d|+# 0 0 ¢ et Run Simulation Tool Vi @iV
%, Launch Simulation Liorary Compier
Project Navigator] \ Herarchy v = a x| & v come! (] [P cataog pa x|
%8, Launch Design Space Explorer I =
Entity Insiance & e = ‘Q X‘
1 @ TimeQuestTiming Analyzer
4 Cyclone V: SCEFA2F23C8 [}
2 LILIIIIIIPPPPPIIIIIIIIIII I I I A A A0 0000 00000077007 v sl instaled P
T Testo1_Project LED 3 Advisors. » ~ Project Directory .
5 No Selection Avalable
6 < ChipPlanner p/28/2016 v Library
7
L 4 Design Partion Planner ject_LED > Basic Functions
9 Netist Viewers >
@ > osP
ﬁ B Signallap I Logic Anyzer > Interface Protocols
= > Memory iterfaces and Controllers.
@ In-System Memory Content Editor
14 > Processors and Peripherals
15 [ Logic Analyzer nterface Editor
18 > Universty Program
17 In-System Sources and Probes Editor ed @ Search for Partner P
19 2
2 4> Programmer U i
JTAG Chain Debugger
g 45 § Faut injection Debugger
25 System Debugging Tools. »
26
27 003
58 i P cataing 5080000;
29 Nios Il Softwrare Buid Tools for Eclpse d
ed;
31 & Osys 1:0]count;
32
33 el Seri
34 & = gedge sys_rst_n)
= Customize.
gg Options.
39 License Setup.
40
41 G Install Devices. v
< > > + Add
*[Type 1D  message ~
a o 332102 Design is not fully constrained for hold requirements
n Quartus prime Timequest Timing Analyzer was successful. 0 errors, 5 warnings
= o 293000 Quartus Prime Full Compilation was successful. 0 errors, 9 warnings
8 v
2« >
£ system(1)  Processing (111)
Opens a Programmer window

100%  00:01:30

ur Pfogrammer

Make sure the USB Blaster’s cable arefcorrectly connected to CPLD’s JTAG port before using
Programmer to download *.sof file. Then click [ Auto Detect] to check the hardware setup is okay or not:

(S Quartus Prime Standard Edition - Ey/Alera/Software/Test01_Project LED/Testd1_Project LED - Test01_Project LED - O X
Fle EGt Wiew Project Assignments Processing Tools Window Hep @ [search steracom | @
O @« Mk C |:[Test_project LD S EEL TS LD E
Project Navigator] )y Herarcny v |= (R 8 x Test01_Project_LED.v g ¥ Chain'.cdf (] ‘\P Cataog Le x
‘; * X| =
i Hardware setup... [USE-Blaster USE-0) | moge: [sTac ~|  Progress: =
A\ Cyclone V: SCEFA2F23C8 [T
(] B S S T o T T T D
B Test01_Project_LED r@y ~ Project Directory
- Fiie Device Checksum  Usercode Program/  Verify  Blank-  Examine  Security Erase ISP Ho Selection Avalable
LS Configure. Chack Bt CLAWP v Library
> Basic Functions
> Dpse
8 Auto Detect > Interface Frotocols
> Memory Iterfaces and Controllers
— W
> Processors and Peripherals
/™ Aod Fie > University Program
¥ Change Fie. @ search for Partner P
< >
b save File
F® Add Device...
Thup
= T Down
> + Add
x|[Type  ID message ~
#|| @ 332102 pesign is not fully constrained for hold requirements
i, @ qQuartus prime Timequest Timing analyzer was successful. O errors, 5 warnings
= © 293000 quartus Prime Full compilation was successful. 0 errors, 9 warnings
8 v
2l 22
H
| system(1)  Processing (111)
100%  00:01:30

Figure 2-16. JTAG Setup
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Below image shows the CPLD has been detected by the Programmer:

& Programmer - E:fAltera/MAX10/Software/Test01_LED/Test01 LED - Test01 LED - [Chainl.cdf]

O *

File Edit View Processing oole  Window Help ’

Search akera.com .|

|é Hardware Setup | |USB-Biaster [USB-0] unde [mae - T ’ ]
D Select Device Pas

|:| Enable real-time ISP to allow background programming when a

Found devices with shared JTAG ID for device 1. Please select your device.

File Devi

b Start Examine Security Erase ISP
@® 10M025C Bit CLAMP
ol stop 10M02SCES
M) Auto Detect

3 Delete

Figure 2-17.
Users click [None] column to choose the *.sof file to

& Programmer - E:fAltera/MAX10/Software/Test01_LED/Test01_LED - Test01_LED - [Chain1.cdf]*

- o x
File Edit WView Processing Tools Window Help ’ ’W. |
|i. Hardware Setup.. | [use-Baster UsB-] | toge: Progress: [ ]
D Enakble real-time ISP to allow backg prog ing when
File Device| & Select New Pragramming File e
wh start
o st0p <none= 10M025C Lookin: | | E\AleraWAX10\SoflwareiTest01_LEDoutput_fles -0 © 0 EE |
@) Auto Detect g My Computer Name Size Type Date Modified
.
T e
& svebvely ﬁ Test01_LED.sof 245 KB sof File 2018/4/23 22:27:40
M Add File...
b save File -
F*® Add Device...
1 up
l‘ﬁl Down
File name: | Test01_LED.sof | _open |
Files of type: | Programming Files (*.50f *.pof *jam * joc *.ekp *.ic) v|| cancel |

Figure 2-18.  Choose *.sof File
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Then toggle [Program/Configure] and click the [Start] button to start a new program:

» Programmer - E:/Altera/MAX10/Software/Test01_LED,/Test01_LED - Test01_LED - [Chainl.cdf]* —

File Edt View Processing Toos Window Hep @ [searchateracom | @

O X

M Auto Detect

X Dekete

*
g

¥ change File

E Hardware Setup..., [USB-Blaster [USB-0] | Mode: [smac - Progress: l ]
|:| Enable reaktime ISP to allow backgr prog ing when
0 | File Device Checksum Usercode Program/ Werify Blank- Examine Security Erase ISP
L Start | Configure Check Bit CLAMP
= Stop output_fiesTest01_LED.... 10M025CU169 00030FC3 00030FC3 [

B save Fie

2
2 &
5 Z

:

l% Down

could check whether the LEDs on CPL ing or not.

- 7
Figure 2-19, rogram *.sof
If the *.sof file is correctly programed, the Prog will'show info like: 100%(SUccesstul). Then users
giary)l

& Programmer - E:fAltera/MAX10/Software/Test01_LED,/Test01_LED - Test01_LED - [Chainl.cdf]* —

[m] X

Fie Edit View Processing Tools Window Help @ .
| moge: [sTac - Progress: 100%(5::::-:-

ing when
Device Checksum Usercode Program/ Verify  Blank- Examine Security ~ Erase ISP
Configure Check Bit CLAMP
ot stop output_files/Testd1_LED.... 10M02SCU16D 00030FC3 00030FC3 [

Figure 2-20.  Program Successful
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2.5

Program *.pof File into CPLD

The Quartus will generate *.pof file after the test project is correctly compiled. The *pof file could be program
into CPLD’s internal FLASH which means the content will not be kept even after repower on. Below image

shows how to program the *.pof file by Programmer Tool:

“ Programmer - E:f#

ra/ 0/Software/Test01_LED/Test01_LED - Test01_LED - [Chain1.cdf]*

- ] X

Fie FEdit Wiew Processing Tools Window Help @ .
E Hardware Selup...‘ |usB-Blaster (USB-0] | wode: [sTAG - Progress: 100%(51::02- I
D Enable reaktime ISP to allow background programming when available
File Device, & Select New Programming File X
i start
b s10p =<none= 10M025C Look in: ‘ E)Altera\MAX10\Software\Test01_LEDioutput_files - | (<> +] BB
B Auto Detect Wy 1y computer Size Ta Raleliodica
82K8
3 veey [] Testo1_LED.pof pof File 201814123 22:27.40
= Change Fi...
b save File
F* Add Device...
T up
1" Down
File name: | Test01_LED.pof [ [ open ]
Fies of type: | Programming Files (*s0f *.pof *jam *joc *.ekp “ic) | | Cancel |

ct ®pof File
button to program the CPLD. Once th
cable to repower on the development bo
*pof is correctly executed.

rogram/Configure column. And then click the Start
ccessfully programmed, users may re-plugin the Mini USB
users could check whether the functionality implemented in

4 Programmer - EyfAltera/MAX10/Software/Test01 |ED/Test01_LED - Test01_LED - [Chainl.cdf]*
Hep @

Fie Edt View Processing Tools Window

- O X

Search attera.com .

|; HardwareSe’(up..| [usB-Biaster wsa-y | ode: [17ac

-

D Enable rea-time ISP to allow background programming when available

-

iy File Device Checksum Usercode Program/ Verify Blank- Examine Security Erase ISP IPS
Confgure Check Bi CLAP
output_files/Test01_LED....
=) Stop tput_files/Test01_LED. 10M0ZSCU168 008503EC oooooooo
CFMO
M) Auto Detect UFM
i Add File.
- Y Change File...
< >
- ml Save File
® Add Device.
Thup /NAT
TDI "
1'h pown >
10M0ZSCU169
TDO
+

Figure 2-22. Program *.pof

(4

QMTECH QM_MAX10_10M02SCU169 Development

Board

User Manual-V01



3. Reference

[1] max10-10m02_08_core_board_vO1.pdf

[2] m10_datasheet.pdf

[3] m10_handbook.pdf

[4] m10_overview.pdf

[5] ug_m10_adc.pdf

[6] pcg-01014 Cyclone® V Device Family Pin Connection Guidelines.pdf

[7] Intel® MAX® 10 FPGA Device Family Pin Connection Guidelines /
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